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Da http://en.wikipedia.org/wiki/Software-defined_radio
"A software-defined radio (SDR) system is a radio communication system which uses software for the
modulation and demodulation of radio signals."

CIAOradio
(Computer Interface Audio Output radio)
By Oscar Steila IK1XPV e Claudio Re I1RFQ
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Preliminary information
Requirements and definitions :
- PC Pentium III a 750Mhz or better ,
- OS Microsoft Windows 98SE, ME, NT, 2000, XP.
- For the use with the Dream software to receive DRM : PentiumIV 2Ghz or better.
- Minimum RAM 256MB (suggested 512MB ).
- Stereo Soundcard 16bit/48kHz for audio output , with speakers .
- 1GB free on HD (Space on HD limit the number of possible recording ).
- CIAOradio ha san USB Hardware interface called H101
How to Install :
Installation of the software is manual :
- Make a folder where you like (e.g. C:\Programmi\Cradio\)
- Copy in this folder all the content of the supplied CD
- Make a link on the desktop from : CIAOradio.exe
How to Uninstall :
-Cancel the folder where you have copied the content of the CIAOradio CD .
- CIAOradio do not install any information inside the registers of the system .

Configuration
-Install the software on the CD
-Connect H101 to the USB plug on the PC . When you install the first time , the Operative System
automatically recognize H101 (as USB speakers) and install the needed driver . (Using Win98 the
CD of the OS could be needed ).
-Launch CIAOradio.exe ( eventually making a link on the desktop)
-CIAOradio presents a configuration dialog . If you don’t see this , go on the toolbar : Setup>Configuration.

2

Sound in device: choose the input device . If H101 is installed and connected , choose the USB device,
typically called “USB speakers” or “USB Audio CODEC”. It is a combobox : press the right arrow
to see the sound card choice .

Sound device OUT 1: device 1 for audio output , typically the Sound card that you have on your PC .
Sound device OUT 2: device 2 for audio output . Auxiliary audio output in case , there is the need to
use Dream for receiving DRM, or any other .There is the need to install the software Virtual Cable
and select it here .Virtual Cable is a virtual audio device that routes the audio to other software
(Dream or other ) . On other software , select Virtual cable as input audio device and the sound card
of your PC as output audio device .
Sound out control (USB H101) : Channel used for control H101 . Set the same as “Sound in
device “ .
ANT1/2 selection - you can select the way of cyclical switch between Antenna 1 and 2 .
-NONE : no switch
-COMn : the switch timing is sent to a COM port . In this case you can drive an external
antenna relay .
-CRH101 : H101 will cyclically switch between Antenna 1 and 2 .
Central freq. Hz : Tuning central frequency . With H101 ,not connected set the central frequency of
the display .
TX mute : Check box that set an audio Squelch with very high RF signals . For the use of
CIAOradio in conjunction with a TX or RTX .
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Aux Display : selecting I&Q xy or I&Q time , you can see ,instead of the knob , the vector or time
representation of the I&Q signals .Could be helpful for checking purposes .

I&Q sampling correction : you can compensate the hardware amplitude and phase errors of H101
and the sound card for improving the image attenuation . Using H101 default is delay 1, GAIN =1.0.
For generic sound cards set delay 0 or 1 e gain 1.0 .
Sampling type : For H101 has to be always set to 48000 Hz .Lower values (44100,22050,11025) could
be used with different sound cards . Samples always 16bit and stereo.
CIAOradio H101 controller info (atinfo) : displays the identification information received from
the controller of H101.
To accept changes , press <OK> otherwise <Cancel>
When you close the dialog box CIAOradio configuration you return to the main window .
If you have changed sound card devices , and also durinog the first installation of H101, could be
necessary to close the software and restart it before changes take effect .
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Main Window

General
On the upper part of the screen you have the spectrum of the frequencies around the set frequency .
The spectrum width could be 48 kHz ( the IF of our receiver ) .
The spectrum easily allow to select the signal you like and see the side signals that could interfere
On the lower left part there is another screen that represent the real time spectrum of the demodulated
signal ( the darker part of the main screen , near the yellow line that represent the set frequency.
In the demodulation spectrum screen you can see the shape of the IF filter ( green line ) , that can be
modified in real time using the mouse .
On the right of the demodulation spectrum screen you can find the buttons that select the
demodulation mode .A virtual red LED light shows the selection .
In the central of the main window an S-meter allows to read the level of the signal received.
Under the S-meter you can find the other buttons that controls the other parameters of the receiver .

On the right there is the display of the RX frequency in Hz. MHz and KHz are divided with a dot.
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Each digit has two buttons that acts as a thumbwell switch .
You can rotate the tuning knob exactly like a mechanical on .Just steadily click on the knob with the
left mouse button and rotate .
On the top of the main window there is a toolbar that allows several other controls .
Quick start
After installing the software and having connected H101 to the USB port let’s launch
CIAOradio.exe. After having set the configuration set , like previously described , let’s go to the
main window .
Connecting an antenna to the ANT1 Input of H101 we can start to set a frequency that we want to
receive , for example 7.050.000.
There are several ways to perform this task :
- Using the mouse , clicking on the +/- buttons of the thumbwell switches .
- Pressing the button <F> on the right of the frequency display .A keyboard will pop up .You can
write the frequency with the PC keyboard or clicking on the keyboard of the pop up window .
<Enter> close the pop up window and set the frequency .If you just set the frequency , push the
button <Tune>.

- Using the knob like previously described : steadily click on the knob with the left mouse button and
rotate .Tuning steps are selectable from the toolbar in the menu TS .
- Rotating the wheel of the mouse ( if present ) .Steps as with the knob .
- Using the mouse directly on the windows that displays the spectrum of the band . If you click on
this screen with the left mouse button , you will tune to the point where you clicked ( marked from
the yellow line ) , or you can click and drag the same yellow line to the point where you like .
If , after setting the frequency , you don’t see signal on the spectrum window , please check if you
have selected the right antenna input (ANT1 / ANT2 ) .You can change the setting , just clicking on
the arrows of the button ANT .
In the same way you can change the value of the IF gain ( +40;+20;0;-10 ) or of the Input attenuator
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(0;+10;+20) .
Demodulation mode is set pressing the buttons in the two columns near the spectrum of the
demodulated signal ( CW ,LBS, USB , etc. ) .
On the left of the tuning knob , there is a Volume slider .
If you see signals but you are not able to listen , please check that the volume slider is not set at zero ,
the same for your external loudspeakers and that the Output button is set to OUT1 , where on the
configuration menu , you have set the internal sound card that you have on your PC ( like previously
described ) .

Buttons on the main screen
CW : selects CW demodulation .The default filter bandwidth is set to around 300 Hz . The shift is
850Hz .
The default bandwidth of the spectrum screen of the demodulated signal is set to 2 kHz .CW is
received in LSB mode : the carrier used for demodulation is set 850 Hz higher than the signal

The bandwidth of the filter can be changed in real time clicking and dragging the
left or right side of the green line with the left button of the mouse .
LSB : selects LSB demodulation .The default bandwidth of the filter is set to
2.5kHz ( between 250 and 2750 Hz ). The bandwidth of the filter can be changed
in real time clicking and dragging the left or right side of the green line with the
left button of the mouse .
The default bandwidth of the spectrum screen of the demodulated signal is set to 3 kHz .
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USB : selects USB demodulation .The default bandwidth of the filter is set to 2.5kHz ( between 250
and 2750 Hz ). The bandwidth of the filter can be changed in real time clicking and dragging the left or
right side of the green line with the left button of the mouse .The default bandwidth of the spectrum
screen of the demodulated signal is set to 3 kHz .On the picture you have a real example of an USB
signal received on air .
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AM : selects amplitude demodulation . In this case the IF filter extends between -4kHz e +4kHz
around the tuning frequency (yellow line). The demodulated signal is represented on a bandwidth of
8 KHz. Note: The spectrum of the demodulated signal extends outside the mask of the IF filter . The
reason is because AM demodulation ( not synchronous ) is not a linear operator .
FM : selects frequency demodulation . In this case the IF filter extends between -6kHz e +6kHz
around the tuning frequency (yellow line). The demodulated signal is represented on a bandwidth of
12 KHz. Note: The spectrum of the demodulated signal extends outside the mask of the IF filter . The
reason is because AM demodulation is not a linear operator
AMs : selects amplitude synchronous demodulation . In this case the IF filter extends between -4kHz e
+4kHz around the tuning frequency (yellow line). The demodulated signal is represented on a
bandwidth of 8 KHz.Tuning is supported from a central tuning bar on the lower part of the S-meter .

LBs : selects the lower side of the amplitude synchronous demodulation . In this case the IF filter
extends between -4kHz e +25Hz around the tuning frequency (yellow line). The demodulated signal
is represented on a bandwidth of 8 KHz. Tuning is supported from a central tuning bar on the lower
part of the S-meter .
UBs : selects the upper side of the amplitude synchronous demodulation . In this case the IF filter
extends between -25Hz e +4kHz around the tuning frequency (yellow line). The demodulated signal
is represented on a bandwidth of 8 KHz. Tuning is supported from a central tuning bar on the lower
part of the S-meter .
9

DRM : Digital Radio Mondiale .In this case the IF filter extends between -6kHz e +6kHz around the
tuning frequency (yellow line) . This signal is translated around 12 Khz in the spectrum screen of the
demodulated signal and sent to the output . Selecting OUT 2 , set to Virtual Cable , like previuosly
described , the signal can be routed to the DRM demodulation software (e.g. Dream or DRM).
LPF : selects an USB demodulation with a low pass of 500Hz .Can be used for selective level
measurements or demodulation of narrow band signals .
ANT1/2 : allows to select between ANT1 or 2 BNC inputs of H101 .
Note : if you have selected the automatic mode on the configuration setup , ANT1 and 2 are
periodically switched
IF gain : allows to select the IF gain between -10,0,+20,+40 dB . Typical values are +20 or +40.
Other values for measuring purposes or when you have extremely high signals on the band .
ATT : allows to select the input attenuator between (0,10,20 dB) . Default value is 0 dB .
IQ / AIQB : allows to select the automatic equalization of the IQ balance that typically improve the
frequency image attenuation .
OUT1/2 : allows to switch between the output device set in the configuration setup .
Vol : slider that sets the volume of the outputs ( OUT1 and 2 ) .
F : activates the pop up of the frequency keyboard .
R : rounds the frequency set following the tuning step .
Example : frequency on the display : 7.005.141 , tuning step :100 Hz .Pressing R the frequency on the
display become : 7.000.100.
How to modify the shape of the IF filter :. The shape of the If filter is represented on the spectrum
screen of the demodulated signal with a green line .The line represents the real frequency behaviour of
the filter and can be modified clicking and dragging with the left button of the mouse .The line became
white and can be dragged .
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If we want to put a notch , like in the picture , we have to place the pointer of the mouse in the lower
part of the screen , just the above frequency line . Steadily click with the right mouse button , drag
down to select the band you like to cut off . If we want to close the notch , just place the pointer on
the upper part of the filter and steadily clicking with the right mouse button , drag to fill the band you
like .It is possible to insert whatever number of notches you like .
Needs a little of practice . After all become natural .
Shown below an example how to cancel a big interference signal with a notch :
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Toolbar Menu File

Clicking <File> you can open a window that allows to select the file.wav that you want to listen .
<PLAY> : starts to listen . The slider run .
<PAUSE> : suspend and freeze the slider .
<STOP> suspend , the slider return .
< >> > quickly load the signal .
< << > quickly rewind the signal .
On the left there is the recording date . On the right start , end and current time of the slider .
When you listen to a recorded signal , the input signal of the receiver is ignored .
•

Start Wave I/Q Recording : start immediately to record all the shown bandwidth on the spectrum
screen (24 o 48 kHz) . Later ( even month or years ) you can listen again choosing to demodulate
whatever signal you can find on the spectrum screen ,like if it was in real time .

<Stop> : Stops the recording process . This wav recording needs an appropriate room on the HD .After
, the most interesting files could be archived on CD or DVD . A dialog box is opened to recall the
name of the recording opened and allows to close it after .

• Start Audio Out Recording : immediately starts to record ONLY the demodulated signal in a wav
file. A dialog box is opened to recall the name of the recording opened and allows to close it after .

-

Exit : close the software .
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Tools

-

Signal Level Trace : opens a window that allows to show how the amplitude of the
demodulated signal change during the time .

-Waterfall : opens a window that allows to show the spectrogram (waterfall) of the band received .
- Waterfall Output : opens a window that allows to show the spectrogram (waterfall) of the
demodulated signal .
-Reference Input : generates a virtual signal at the input with a lot of carriers with different
amplitude. One of them change during the time in 10dB steps . It was used to develop the system and
can use to expertise with the system without connect any antenna .
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•Reference Ouput : Generates a virtual signal on the output with two carriers .

-Off : switch off the reference signals .

Mode
-

I&Qstereo : this display mode allows to see on the spectrum screen a bandwidth of 48kHz
(-24kHz a +24kHz). The peak in the central of the screen is the noise around DC , generated
from the direct conversion . It is the same like the zero beat line that you have at DC on all the
Spectrum Analyzers .
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If you don’t like this , you can go in USB RX mode that simply hide it , but the displayed band will be
less than a half .
-Real : only the upper part from 0 a +24kHz is displayed .The rising of the noise is on the left of the
screen .
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-USBrx : similar to the real mode , but the lower and upper part of the spectrum are cut .

Bwidth
-1,....20 kHz : allows to select the bandwidth displayed on the screen of the spectrum of the
demodulated signal . It changes while setting different demodulation modes .

AGC (Automatic Gain Control )
Speed can be set between :
-Normal
- Fast
- Slow
-Off : switch off the AGC.
Note : the S-meter display do not follow the AGC ,but quickly follows the rms ( root mean square )
calculated inside the value the bandwidth of the spectrum of the demodulated signal . The AGC
behaviour is displayed by the red bar on the left of the window of the spectrum of the demodulated
signal .

NB (Noise Blanker) It is suggested to activate only in presence of pulsed noise .
- NB ON
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- NB OFF

TS (Tuning Step)
-10Hz,... 1MHz : allows to change the tuning steps used from the
tuning know or from the mouse wheel .

Setup
-Configuration : open the configuration windows as previously described .
-Sound In : open the recording volume control of the operative system .
With H101 is normal to have an error message returned because H101 do not have any mixer control ,
having only one source . If you get this message , just press OK .
-Sound Out : open the playing volume control of the operative system .
BE CAREFUL : under the voice Options of the mixer control panel you can select several different
controls for each of the cards installed in the system .For example : H101, Internal Sound Card ,
Virtual Cable etc.
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Here you have for exampe the output USB mixer and his correct settings :

As previously explained the recording mixer of H101 has no inputs :
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With Virtual Cable , the original settings are as follow :

-

Sys Info : give a report with some info about the PC used useful for remote debugging .
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ReadMem.

- Select memory : Selecting this , you will find a searching menu to find memory files . For
example : RAI_657_AMS.

-1,..20 . Twenty quick buttons helpful for searching the memory that we need at the moment . If the
position is used , on the right of the number , you can see the frequency and the demodulation mode .
Files are read from the directory \radiomems\ instead of the directory where you have put the file
CiaoRadioxxx.exe (xxx depends on the version ) .
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WriteMem.
- Select memory : Selecting this , you will find a searching menu to
memorize files .For example : RAI_657_AMS. You can make different
directories to order the files into categories like : Broadcast, HAM, Marine...
-1,..20 Twenty quick buttons helpful for memorize the stations . If the
position is used , on the right of the number , you can see the frequency and
the demodulation mode . Files are read from the directory \radiomems\
instead of the directory where you have put the file CiaoRadioxxx.exe (xxx
depends on the version).

Help
- Help : This file .
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- About :

Antenna
-Input 1
-Input 2
Same function as the button under the S-meter .It also act as label for the virtual led under , that is blue
or red following the selection of the antenna 1 or 2 .

S-meter
This instruments displays the signal level in S units or in dBr. You can switch between the two
measurements just clicking on the S-Meter screen with the left button of the mouse .

When you use the AMs ( synchronous ) demodulation , on the lower part of the S-meter you will have
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a blue bar for central the tuning .

Overload
If you overload the receiver with signals too high , the software shows the OVERLOAD label .

In this case you need to insert some levels of Input attenuation or decrease the IF gain .

In this case you need to insert some levels of Input attenuation or decrease the IF gain .
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Antenna relative gain measurements
CIAOradio allows to measure the gain of an antenna comparing with the gain of a known antenna .
The software and the CODEC used inside H101 allow to measure the signal with a dynamic range of at
least 90 dB with great accuracy .It is possible to compare two antennas switching them with an
architecture like in the picture . Using H101 , the antenna switch is integrated .Just connect antenna A
and antenna B to the input ANT 1 and ANT2 . Check manually the switch between the two antennas (
button ANT1&2) and then choose the signal to use in the measurements . Broacasting station are
suggested but also beacons or every signal into the selected band could be used . While you can
manually compare the antennas , it is much more effective and objective to make a wide and long
statistical and automatic recording of the results that could change during the time , due to the different
behaviour of the propagation .

To activate this function open Setup on the toolbar and activate the command :
ANT1/2 selection – this list allows to select how to generate the command for switching between
the antenna input .
-NONE : no switch
-COMn : select an asynchronous serial port (COM). In this case the switching signal is on a
pin of the COM port ( see drawing ) and could be used to switch a relay .

-CRH101 : select the internal antenna switch of H101 .
To record the signal , open : Tools-> SignalTrace .
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A window like this will pop up :

This window displays the amplitude of the signal during the time .
The scale could be adjusted moving with the mouse the points at the end of the yellow lines
The green bar on the left of the window displays the instantaneous value of the signal .
The horizontal trace represents the Time . If you switch between two antennas , you will see part of the
trace Blue ( ANT1 ) and part of the trace RED ( ANT2 ) .
If you use a COMn to switch the colours could be different .
On the toolbar on the upper part you can set the other parameters :

VideoBandWidth
Allows to use a low pass filter on the signal . Bandwidth could be set to : 30, 10, 3, 1 Hz.
Time Span
Set the total time span on the horizontal axis for each screen : 5, 15, 30 or 60 s.
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Switch Rate
Set the speed of the switch : 0.13, 0.38, 1, 3, 10 sec.
For antenna measurements , we suggest the values : 1,3,10 s. because there is an overshoot
on the filters in the order of 0.1s .
Log Recording
With this menu you can start or stop to record in a log file the amplitude of the signals of the two
antennas .The log files could be examined after with the use of the program CIAOlog , that is in the
same directory of CiaoRadioxxx.exe .

CIAOlog
It is a software that analyze the log files recorded with CIAOradio. After opening the file
CiaoLogxxx.exe (depending on the version ) , this window will be displayed .

To open the file log go in the toolbar menu ; File -> Open , a dialog box that allows to select the file
will pop up.

The opened file will display the amplitude of the signal of the two antennas during the time .
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This file shows has a great difference between the signals of the two antennas .

To display the two antennas signals select : Mode -> Ant1 +Ant2 Measure
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In the same menu we can set also : Single signal , Single signal, Ant1 signal, Ant2 signal .
To compare signals , obviously the right menu is : Ant1 +Ant2 Measure .
The difference between the amplitude of the two antennas is not stable during the time , hence is
better to proceed to a statistical analysis selecting :
Tools->Statistics

29

On the upper right corner are summarized the statistical data .
The most important one is the last one that shows the mean gain difference between the two antennas
( 38.70 dB ) .
Using the mouse it is possible , clicking and dragging the points at the end of the green lines ) to
select different ranges on both vertical and horizontal scales .
This changes the analysis , while typically is better to compute with the maximum number of
samples .
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H101dds
It is a software that allows to use H101 as DDS sinusoidal generator . The output signal is
unmodulated continuous (CW) and can be set between 1Hz e 65 MHz at a typical level of -15dBm.
H101dds.exe can’t be used at the same time with CIAOradio.exe
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FAQ :
-

. Why at the central of the spectrum , while using the I&Qstereo mode , you see a signal
even without any antenna connected ?

This display mode allows to see on the spectrum screen a bandwidth of 48kHz
(-24kHz a +24kHz). The peak in the central of the screen is the noise around DC , generated
from the direct conversion . It is the same like the zero beat line that you have at DC on all the
Spectrum Analyzers . If you don’t like this , you can go in USB RX mode that simply hide it , but the
displayed band will be less than a half .Generally it is useful that the tuning window will be kept out
of this zone .
. Why the tuning frequency it is not always in the central of the spectrum screen ?
The "central frequency " is set to a value near the nominal but "modified " to decrease spurious of the
DDS (the dynamic range of the receiver is high ).
. Why in some frequencies of H101 you can see some spurious ?
The dynamic range of the receiver is high , some arises from the DDS spurs , some come from the USB
clock that is at 12 Mhz and armonics . .
. Why , if you change the AGC time , the S-Meter don’t change behaviour ?
The S- meter displays the rms (root mean square ) level inside the IF filter and it is not affected
from the AGC . This allows you to always monitor on the S-Meter the real signal coming from the
antenna .
. Why , if I have activate the AIQB button , the attenuation of the image symmetrical respect to
the DC is not always better ?
This automatic system of balancing is based on statistical computing and could not be always
effective .

.Why Virtual Cable is needed to use the software DRM or Dream ?
Virtual Cable is needed if you want to demodulate standard that are not inside Ciao Radio or if you
want to use any other different software to demodulate the signals .

Other Software :
Virtual Cable
http://spider.nrcde.ru/music/software/eng/vac.html
" Virtual Audio Cable is a Windows WDM multimedia driver allowing you to transfer audio
(wave) streams from one application to another. It creates a set of "Virtual Cables" each of
them consists of a pair of the waveform input/output devices."
Demo Version 3.06 allows to build only "virtual cable ", enough for the use with CIAOradio .
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Dream http://sourceforge.net/projects/drm/
"Dream is a software implementation of a Digital Radio Mondiale (DRM) receiver. "

Reference : http://digital-radio-mondiale.wikiverse.org/

Notes on the software :
CIAOradio.exe e CIAOlog.exe was wrote using l'IDE Bloodshed DEV-CPP
http:\\www,bloodshed.net

The manual was written using : AbiWord, http:\\abisource.com

The history :

CIAOradio (Computer Interface Audio Output radio) start from the wish of Oscar Steila,
IK1XPV and Claudio Re I1RFQ, of experimenting the new SDR ( Software Defined Radio )
technologies on 2004.
A lot of Hams or SWL ,while using the first versions of the software gave a lot of contribution
to fix some of the bugs . Some other has to be driven out , time by time .
Many features of the software was suggested from many other volunteers that has spent a lot of time
with CIAORadio .

We would like to thank for the suggestions , patience and willing to help us and understand our limits
included not to be able to recall all the person that has contributed to this work .

Among the other , in casual order :

Michela e Mirtha,
Bill Miller, K4TYE,
Anselmo Stiffan, IZ3BGJ,
I-Link group , http://www.i-link.it,
Giampiero Bernardini, http://radiodxinfo.blogspot.com,
Angelo Brunero, I1QLD,
Andrea Borgnino, IW0HK
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Pino Pastine, IK1DQG,
Rossano Sorrentino IK1NAO,
Paolo Romani,
Alberto Bernardelli ,
Andrea Negrini ,
Alessandro Santucci ,
Roberto Magnani,
Rodolfo Zucchetti ,
Silvia Steila per la grafica
And many other …..
License
Note: CIAOradio software is given without any guarantee . The User accepts all the risk that could arise using
this software . The use of the software could cause or require the reset of the PC in case of failure and could
damage data in the PC .
All rights are reserved .The License allows the use of the software for hobby and personal use .Any commercial
use is strictly prohibited if not allowed with written consent .It is not allowed to try to decompile , modify ,
translate or disassemble the software totally or partially . For using the full edition of the software the
registration is needed .

Pay attention :
CIAOradio is a software that process the audio signal in real time .If problems could arise during the
use , the PC could stop or reset . Unsaved data present at this time on the computer could be lost .It is
suggested to back up the PC before installing and using CIAOradio.
Listen radio waves has different rules and laws in each countries . To know and respect them it is
suggested to consult the National Telecommunication Ministry .
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